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Communication is the act of conveying meanings from one entity or group to another through the 

use of mutually understood signs, symbols, and semiotic rules. 

*The following figure represents types of communication 

                                      (Fig 1) 

 

         Learning objectives of Effective communication 

1. Development of Interpersonal Skills 

2. To express effectively & with maximum efficiency 

 

Communication skills are beneficial in and out of the workplace. Having the ability to clearly 

communicate instructions, ideas and concepts can help you find success in any career. With practice, 

anyone can develop their communication skills. 

 

 

 

One of the most critical skills in effective 

communication is Active listening. 

Developing this soft skill will help build and 

maintain relationships, solve problems, 

improve processes and retain information 

such as instructions, procedures and 

expectations. 

 

1. What is Communication? 

          Class XII          Communication Skills 

2. Active Listening 
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2.1 Why is active listening 

important in the workplace? 

Whether we are seeking a new job 

opportunity, striving to earn a 

promotion or working to improve in 

our current role, improving our active 

listening skills will help us succeed. 

Much like critical thinking and conflict 

resolution, this soft skill will help 

increase our value. 

Here are several benefits of being an 

active listener: 

• It helps us build connections. 

 Active listening helps others feel comfortable sharing information with us. When we demonstrate our 

ability to sincerely listen to what others have to say, people will be more interested in communicating 

with us on a regular basis. This can help open up opportunities to collaborate with others, get work 

done quickly or start new projects. All of these things can help lead us to success in our career. 

• It helps you build trust. 

When people know they can speak freely with us without interruptions, judgment or unwelcome 

interjections, they’ll be more likely to confide in us. This is especially helpful when meeting a new 

customer or business contact with whom we want to develop a long-term working relationship. 

• It helps you identify and solve problems. 

Actively listening to others will help you detect challenges and difficulties others are facing, or 

problems within projects. The more quickly you’re able to spot these issues, you sooner you can find 

a solution or create a plan to address it. 

2.2 Four Steps to Active Listening 

Active listening requires four discrete steps. 

CONTACT—connect with the participant who is contributing; eye contact, open posture, and 

nonverbal responses. 

ABSORB—take in all aspects of the spoken message, implicit and explicit and nonverbal clues. Do 

not judge or evaluate. 

REFLECTIVE FEEDBACK—mirror, reflect, or feedback what you have heard and why the contributor 

claims to be valid. 

CONFIRM—receive confirmation from the speaker that you heard the participant’s message 

accurately. If not, start the method over again at the beginning by having the speaker restate their 

view. 

 

 

 



3 
 

  2.3 Demonstrating Active Listening skills 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Story teller 

In this game, the teacher starts a story with a beginning phrase, and then each child in the classroom adds one word 

to the story in turn. Students must be active participants and follow the story closely so that when their time comes 

to add a sentence, the story will make sense. Another way to practice this is by playing a traditional game of 

Telephone where a message is passed around the room to see if it stays the same. 

 Active Listening Skills(game) 

Directions: Read and listen to the statements below. After reading and listening to the teacher read the statements, 
write a response for each statement demonstrating reflective listening on the part of you the listener. Your answer 
should demonstrate the response. Remember a dialogue is a conversation between two people. One person sends 
a message (the statement. The person who receives the message then responds (your written response). Make sure 
to include all of the points each speaker makes. Do not assume (Note: offering reasons, solutions or excuses for 
behaviour is not part of the reflective listening response and must be avoided.). 

In each of your responses, underline all words that show you will restate the points made by the original speaker. 
Look at the example below. Note each part of the sender’s statement is also mentioned in the reflective listening 
statement. 
 
• (Statement) I get furious with him when he says things that suggest that I don’t take good care of the kids. 

• (Active Listening Response) What I think I hear you saying is that you feel furious when he implies that you’re not 

a good care giver for your kids. 

 

From the statements listed below, select a different phrase to use for each one of the dialogues you need to 

complete. 

• “What I think I hear you saying is…” 

• “In other words, you think that…” 

• “Correct me if I’m wrong, but aren’t you saying…” 

• “Let me review what I’ve heard you say. Please correct me if I leave anything out.” 

• “I hear you saying…Is that right?” 

 

1. Father to Son/Daughter: “I am sick and tired of you asking to borrow the car/bike when you haven’t completed 

your homework or your chores, you leave your room in a total wreck and you have been disrespectful to your family. 

You need to grow up and learn to show some respect. 

Response: 

2.Teacher to Student: “I am very concerned about your lack of progress in this course. You haven’t been keeping up 

with your work and the work that you have been submitting is of poor quality. You are a senior and this course is a 

graduation requirement. If you don’t start turning in your work you are going to fail this course and possibly miss 

graduation.” 

Response: 

3. Friend to Friend: I just don’t know what to do about my parents. It seems like they just don’t understand me. 

Everything I like seems to go against their values, and they just won’t accept my feelings as being right for me. It’s 

not that they don’t love me, they do,But they just don’t accept me. 

Response: 
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 2.4 Designing poster on steps of Active Listening 

                                 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Interviewing is a skill in and of 

itself, one in which our ability 

to interact with the 

interviewer and to articulate 

our thoughts are factors that 

are just as important in getting 

the job as are the 

qualifications listed on our 

resume. 

 

 

 

3. Interview Skills 
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3.1  Interview Do’s and Don’ts 

 3.1.1 DO’s 

a) What to do before an interview  

• Get a good night's sleep the night before. 

• Do research.  

• Eat a good breakfast.   

• Prepare questions beforehand. 

• Know who will be interviewing and learn a bit about their background. 

• Know your strengths and put together a list of them. 

• Turn off your cell phone 

• Prepare a solid list of references 

 b) What to do during beginning of an interview 

• Do try to sparkle! Use gestures in your conversation. Make sure they are smooth and 

emphatic. 

• Do smile. 

• Do make sure you get the interview’s name right and use it a few times in the interview 

• Do go to the rest room before you visit the employment lobby. It is 

• embarrassing to interrupt an interview, and you want to be as comfortable as possible 

 c)  What to do during an interview 

•  Do look the interviewer in the eye. Recruiters place a lot of emphasis on eye contact.   

• Do take notes 

• Let your achievements speak for you. 

• Take a second before answering a question. 

• Sit up straight. 

• Ask questions. 

   d) What to do after an interview 

• Do let the interviewer decide when the interview is over. 

• Do ask the interviewer when you will hear from him or her again if he or she does not offer 

the information. 

• Drop off a thank you note. Always thank interviewer after you have left. 

• Follow up appropriately. 

• Create a list of items that you did well and you like to improve on. 

      3.1.2 Don’ts 

• Don’t be late. In fact, plan to be early for any scheduled interview. If you are late or arrive 

just in the nick of time, the interviewer will start to wonder 

• Don’t sit down until you are asked. 

• Don’t lean on or put your elbows on the interviewer’s desk. Sit back in your chair, so the 

interviewer can see more of you. Sit erect. 

• Don’t show your nervousness by drumming your fingers, swing your leg, or cracking your 

knuckles. 

• Don’t talk too quickly 

• Don’t digress from your points. Answer questions directly. 
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• Don’t use words you do not know meaning of 

• Do not use slang. 

3.1.3 To teach interview skills in high school, we should follow these four steps: 

• Introduce interview skills 

• Talk about why good interview skills matter 

• Explore what good job interview skills look like 

• Group project 

A practical, and interactive activity for participants to learn how to prepare for a job interview. This 

activity will help them avoid some common mistakes before or during a job interview. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Warm- up Activity: 

Words “ Interview” will be written on the Whiteboard/blackboard which be followed by 

discussion..The participants will be put be questions like: 

a. When was the last time you had an interview? 

b. Did you have good or bad experiences? 

c. Do you have any interview- related stories? 

d. d. Brainstorm some common mistakes before or during an interview and write them down. 

 

 https://www.youtube.com/watch?v=S3l7COBI77U 

A small video clip will be played will played for a few times and then the 

 

Students will prepare five questions of their own on what they should andshould not do during an 

interview . For example, 

“What should you prepare for your interview?” 

“What should you do at the interview?” 

“What shouldn’t you do at the interview?” 

 

(3) On the whiteboard, write the following questions and ask the students to repeat with you a few 

times, and then pair the students to do the 

questions and answers. (Optional: The teacher can write down the participants answers on the 

white board.) 

A. What should you do before the interview?  

B. What should you do at the beginning of the interview? 

C. What should you do during the interview?  

D. What shouldn’t you do at the interview? … 

E. What should you do after the interview? 

 

https://www.youtube.com/watch?v=S3l7COBI77U
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  Summary                                   

A classroom environment relies heavily towards your classroom climate. Students with effective 

communication skills will be more likely to contribute to class discussions, will be more productive 

members in group projects, and will ultimately gain more from their experience in the class. Learning 

and practicing writing skills help students to handle professional and social tensions.  

 

 

 

 

  

 

 

 

 

 

        

 

 

 

 

 

 

Actvity  ( Group Project) 

All about me 

One of the first steps in an application process is telling the school /college/company a little bit about 

yourself.The students write a paragraph about themselves giving whatever information they think a 

potential school or employer would want to know including their education. Then, they will write a second 

version of their paragraph that leaves out some of the information in the first and also includes other 

information not in the first version. Collect students’ papers and choose some of the best pairs to share 

with the class.)Have students work in pairs to look at the two versions of the about me paragraph with 

each person in possession of one version. Without reading each other’s copies, the students will  talk until 

they can point out which information each version has that is different from their partner’s and what 

information each version is lacking. 

 

References 

: Google 

: You tube 

: British council Library 
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Motivation is defined as the drive required to engage in goal-oriented behaviour.  Motivation is inner 

urge to do something and self-motivation is ability to do what needs to be done without the influence 

or thrust from other people or situations. Self-motivated individuals are asset to the world, their 

country, their families and to themselves. Self-motivated individuals practice righteousness. They do 

what is required to accomplish their goals.Self-motivated people have elevated spirit and are full of 

positivity. For them nothing is impossible. They are focused on their goals and objectives and diligently 

achieve their aims.  

Self-motivation is important because 

• It increases individual’s energy and activity. 

• It directs an individual towards specific goals. 

• It results in initiation and persistence of specific activities 

• It affects cognitive processes and learning strategies used for completing similar tasks. 

1.1 Finding and listing motives 
Motivation is classified in different types by different 

authors such as motivation based on physiological and 

psychological needs. Physiological motivation is based 

on the physical needs to satisfy hunger or thirst. 

Physiological motivation directs the behaviour towards 

satisfying specific bodily needs. Psychological 

motivations can be guided by need for achievement and 

need for affiliation. The need for achievement is a social 

form of motivation involving a competitive drive to meet 

the standards of excellence. The need for affiliation 

involves the need to seek and enjoy close and 

cooperative relationships with others and be loyal to a 

friend. Motivation is also classified as internal or external 

motivation. In case of internal motivation, an individual 

demonstrates a desire to do his/her work without any external reward. External motivation occurs 

when we feel driven by outside forces, performing an activity either to obtain a reward or to avoid 

punishment. For example, a student who is internally motivated will learn, complete the assignments 

on his/her own, whereas a student who is externally driven will be completing lessons to avoid 

punishment or to gain reward. Motivation, basically answers “why”, the reason behind doing a task. 

A person, may be internally or externally motivated. in different situations or may be driven by 

physiological and psychological needs. One should identify the motivation in every occasion to handle 

oneself better.  

 

       Class XII              Self-Management Skills  

1. Self Motivation 
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1.2 Finding sources of motivation and inspiration 
Following are the sources of motivation and inspiration. 

• Music 

Music is the language of the soul. A good inspiring piece touches every heart and can help create 

miracles.  

• Books 

Books are said to be best friends. They expand our horizon of thinking. They help us visualize the 

unknown and unchartered territories beyond our capacities. Books about heroic acts, inspiring lives 

and stimulating creativity help readers move beyond their routine lives. 

• Activities :  

Engaging in positive and skill enhancing activities keep our spirits high. Competitions, games, 

simulations, interviews for various committee positions are found to encourage, motivate and inspire 

students.  

• Expansive thoughts:  

Thinking and discussing big and positive ideas motivate us to reach our highest potential.  

• Living in the present :  

Being present where we are rather than where we are not, brings in peace and calmness in our life. A 

calm and peaceful mind can help us achieve wonders. This quality of being aware and conscious of 

one’s self in present moment is also called mindfulness. Mindfulness helps students to pay attention, 

reduce stress and helps promote thoughtful approach towards life. 

• Dreaming big :  

Dreaming big is a journey not a destination. Dreaming big helps us to be mentally prepared to take 

that big leap forward. Only when we aim high, we get  motivated to work hard and achieve big things 

in life. 

 

 

 

2.1 Meaning of personality 

Personality is relatively enduring 

set of traits. These traits are made 

up of  emotional, behavioral and 

mental set of characteristics. 

Heredity has been found to be 

determining personality apart 

from environmental forces. 

Personality is shaped through 

family, culture, society, education 

and other environmental factors.  

2.2 Influence of personality  

Personality affects all aspects of an individual’s performance, even how he/she reacts to situations in 

life. Individuals shall set clear goals for themselves and diligently pursue them. Behavioral tendencies 

like anxiety, stress, perseverance and conscientiousness reflected in personality traits can influence 

academic performance.  

2. Personality Types, Traits and Disorders 
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2.3 Basic personality traits 
According to trait theory, combining a set of observable traits into a group forms an individual’s 

personality. One popular personality classification is big five. The Big Five,  global traits associated with 

work . are listed below: 

• Extraversion: Gregarious, assertive and sociable.(Opposite reserved, timid, quiet.) 

• Agreeableness : Cooperative, warm and agreeable.(Opposite cold, disagreeable and 

antagonistic) 

• Conscientiousness : Hardworking, organized and dependable(lazy, disorganized and 

unreliable) 

• Emotional stability : Calm, self-confident and cool(insecure, anxious and depressed) 

• Openness to experience : Creative, curious and cultured(narrow interests) 

 

2.4 Common personality disorders 
Following are the common personality disorders. If anyone is identified with these disorders, 

counselling shall be provided by family members, teachers and counsellors. 

• Paranoid 

Feeling extremely nervous and worried because you believe that other people do not like you or are 

trying to harm you. 

• Antisocial 

Is characterized by a pattern of persistent disregard for and violation of the rights of others. 

• Schizoid 

Is characterized by a lack of interest in social relationships and people tend to be distant, detached 

and indifferent. 

• Borderline  

Is marked by an ongoing pattern of varying moods, self-image and behaviour. These symptoms result 

in impulsive actions and problems in relationships. 

• Narcissistic 

Is a condition in which people have an inflated sense of their own importance, a deep need for 

excessive attention and admiration and lack of empathy. 

• Avoidant 

Avoidant personality disorder is characterized by feelings of extreme social inhibition, inadequacy, and 

sensitivity to negative criticism and rejection. 

• Dependent 

Dependent personality disorder is a condition marked by an overreliance on other people to meet 

one's emotional and physical needs. 

• Obsessive  

Obsessive-compulsive personality disorder (OCPD) is a personality disorder that's characterized by 

extreme perfectionism, order, and neatness. 
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Lets’ Do It !! 

Activities 

Session A. Group Discussion on identifying needs and desires in general 

Session B. Discussion on sources of motivation and inspiration, finding their own sources 

Session C. Demonstrate the knowledge of different personality types. Try to identify your own 

personality  

Session D. Essay on reflections on  self-personality type 

 

 

A 1, A2, A3, A4 
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1.1 INTRODUCTION TO SPREADSHEET APPLICATION 
OpenOffice Calc is a spreadsheet program, a part of the free OpenOffice suite. The program is easy to 
use and contains most of the commonly used features found in commercial spreadsheet programs. 
OpenOfficeCalcis a software that helps in 
performing calculations using formulae and in 
analysing the data.  
 
Do you remember your Mathematics notebook 
of your primary class?  
It has small boxes to practice mathematics. 
These boxes are intersection 
of horizontal rows and columns. 
 
A spreadsheet or electronic Spreadsheet is also 
a long sheet of rows and columns on the 
computer screen. This helps to manage and 
organize data in rows and columns. 
Spreadsheets can be used to do calculations on data, create data reports, manage accounting 
documents, do data analysis, etc. You can also create graphical representation of data. 
 
Another term that is used in a spreadsheet software is Workbook. A Workbook is another name for 
OpenOffice Calc file. A Workbook is a collection of one or more worksheets in a single file. Each sheet 
can have many cells arranged in rows and columns. In this chapter we will be discussing about Apache 
OpenOffice Calc 4.1.5. You regularly get updates of these softwares. 
 

1.2 SPREADSHEET APPLICATIONS 
Spreadsheet programs have become very popular because of the following features: 
• Built-in functions make calculations easier, faster, and more accurate. 
• Large volumes of data can be easily handled and manipulated. 
• Data can be exported to or imported from other software. 
• Data can be easily represented in pictorial form like graphs or charts. 
• Formulae are automatically recalculated whenever underlying data values are changed. 
 

1.3 CREATING A NEW WORKSHEET 
In this section, we will discuss how to start OpenOfficeCalc, components of Calc screen. Also we will 

learn how to create a new workbook and save it. 

1.3.1 Starting OpenOffice Calc 
To start OpenOffice Calc: 
 

1. Click Start ➢All Programs ➢OpenOffice 4.1.5 ➢OpenOffice Calc.  

     Class XII                             ICT Skills 

            Unit 1. Performing Tabulation Using Spreadsheet Application 
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2. A spreadsheet workbook named Untitled1 opens up in an OpenOffice Calc application 
window (Fig. 1). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
                           Fig. 1  OpenOffice Calc worksheet 
 

1.3.2 Components of a Calc Screen 
 
Title bar The Title bar is located at the top of the Calc window. It displays the name of the workbook 
on which you are currently working. When you create a new worksheet, is named as Untitled 1, 
Untitled 2,  and so on. A workbook is a collection of one or more worksheets. The right side of the title 
bar contains the Minimize, Restore Down or Maximize, and Close buttons. 
 
Menu bar  The menu bar is located below the Title bar. It has commands like File , Edit, etc. 
Clicking on each menu option displays a list of commands. 
 
Standard bar  This bar contains icons (buttons) to provide quick access to commands such as New, 
Open, Print, Copy, and Paste etc.  
 
Formatting bar It has buttons and drop-down menus that allow you to select a formatting option like, 
font, font color, alignment, number format, border, and background color. 
 
Formula bar It contains the Name Box and a long white box, known as the Input line. 
 
Name Box  It is present to the left of the Formula bar and displays the address of the selected cell. 
 
The rest of the window contains the spreadsheet. It is divided into rows that have a number at the left 
of each row, and columns with a letter at the top of each column. 
 

Title bar Menu bar Standard 

bar 

Formatting 

bar 

Active 

cell 

Columns 

Rows 

Sheet tabs 

Status bar 

Formula 

bar 

Side bar 

Name 

box 
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Worksheet tabs A workbook, by default, opens three worksheets named as Sheet1, Sheet2, and 
Sheet3. You can click any sheet tab to open that worksheet.  
To insert a new worksheet, the steps are: 

1. Clicking the empty area after the sheet tab. 
2.  The Insert Sheet dialog box appears. (Fig 2) 
3. Select the required option and click OK 

 
                                          Fig 2   Inserting a new sheet 

 
 
You can also rename the sheet. Simply, double-click the Sheet name and type the new name. 
Rows and columns A worksheet in OpenOffice 4.1.5 Calc has 1,048,576 rows and 1,024 columns. The 
rows are numbered from top to bottom along the left edge of the worksheet as 1, 2, and so on. 
Columns are labelled from left to right with letters A…Z, AA…AZ, A…BZ…AAA…AAZ, 
ABA…ABZ…AMA…AMJ. 
 
Cell and Cell Address A cell is formed by the intersection of a row and a column. Each cell has a unique 
address which is formed by the intersection of row number and column letter. For example, a cell 
formed by intersection of column F and row 5 will have address F5. 
 
Active Cell: Data is entered in a cell. To enter data in a cell, we have to first select it. The selected cell 
is called the active cell and is highlighted with a thick border. Also, the address of the active cell is 
displayed in the Name box. 
 
Range of cells: A block of adjacent cells which are selected is called range of cells. For example, if the 
cells from A1 to B5 are selected, then the range of selected cells is referred as A1:B5. The cells in this 
range are – A1, A2, A3, A4, A5, B1, B2, B3, B4, and B5. 

Click blank 

area to add 

more sheet 
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1.3.3 Creating a New Workbook 
 
The steps to create a new Calc workbook are: 
1. Select File  ➢New➢Spreadsheet. 
Or 
Click the New Document drop-down menu 
arrow on the  
Standard bar and selectSpreadsheet. (Fig 3) 
Or 
Press CTRL + N. 

 
1.3.4 Saving a workbook 

The steps to save a workbook are: 

1. Select Save option from the File menu. 

Or 

Click the Save icon on the Standard bar Or Press Ctrl + S 

If you are saving a workbook for the first time, a Save As dialog box will appear.  

2. Type the file name and choose a location to save the file. Notice that the file extension is 

.ods. 

 

1.4 OPENING WORKBOOK AND ENTERING TEXT 
In this section, we will learn how to open an already saved workbook. Also, how to enter data in a 

cell. 

1.4.1 Opening a Workbook 
The steps to open an already saved workbook are: 

1. Select Open option from the File menu. 

Or 

Click Open icon on the Standard bar. 

Or 

Press Ctrl + O 

2. The Open dialog box appears. 

3. Select the drive and the folder from where you want to open the file. 

4. Select the file and click Open button. 

 

1.4.2 Entering text 
To enter data in a cell,  

1. Select the cell. 
2. Type the content. 
3. Press ENTER key. 

 
You can enter numbers, text, and formulas in a cell. By default, the text is left-aligned in a cell and 
numbers are right-aligned. 

 

 

Fig 3 New button on Standard 

bar 
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To cancel the data you have entered before pressing the ENTER key, press the ESC key. 
 

1.5 RESIZE FONTS AND STYLES 
We can always change the font, style and size of the text or data entered in a worksheet. This can be 

done before typing or after typing the content. 

The options for formatting data/text are available on the Formatting bar (Fig 4). The use of each of 
the options is shown in the figure. 
 
 
 
 
 
 
 
 
 
 
 
 
 
        Fig. 4 Formatting bar 

 

1.6 COPYING AND MOVING  
In this section, we will learn how to select cells, rows, and columns. We will also discuss how to insert 

and delete cells, rows, and columns. How to change the row height and column width is also discussed 

here. 

Before performing any operation, like, making text bold, changing text color, etc, on a range of cells, 
you need to select the range. 
A range is a rectangular block of contiguous cells, i.e.,  
 
cells that touch each other, especially along a line.  
 

1.6.1 Selecting Cells 

You can select range of cells in any one of the following ways: 
 

• Using the mouse 

• Using the keyboard 
 
 

Left-aligned 

 
right-aligned 
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Using the mouse 
 
To select a range of cells using the mouse, the steps are: 
1. Click the cell you wish to start your selection from. 
2.Click and hold the left mouse button down, drag the 
mouse 
pointer to the diagonally opposite corner cell.  
For example, if the range A1 to D3 is to be selected, 
place the  
mouse pointer at cell A1. Hold the left mouse button 
down and  
drag it to the cell D3. The range A1 to D3 is represented 
as A1:D3. 
When you select the range, all the cells appear 
highlighted (Fig. 5). 
 

 
Using the Keyboard 
To select a range of cells using the keyboard, the steps are: 
1. Place the cell pointer at one of the corner cells of the range to 
be selected. 
2. Press the SHIFT key and move to the diagonally opposite corner 
cell using the arrow keys. 
3. Release the SHIFT key when the required range has been 
selected. 
 
Selecting Multiple Ranges Simultaneously 
To select multiple ranges, do the following: 
1. Select the first range of cells. 
2. Hold the CTRL key and select another range of cells. 
3. Repeat step 2 to select more ranges if required (Fig. 6). 
 

 
Selecting the entire row 
To select the entire row in which the cell pointer is positioned, click 
the row heading. 
 
Selecting the entire column  
To select the entire column in which the cell pointer is positioned, 
click the column heading. 
 
Selecting the entire worksheet 
To select the entire worksheet: 
 
Press CTRL + A  
Or 
Click the blank button (called the Select Allbutton) at the junction  
of the row and column headers.(Fig 7) 
 

 

 

 

Fig 5 Selecting range using mouse 

Fig 6 Selecting multiple range of cells 

Fig 7 Select All button 
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1.6.2 Copying Cell Contents 
 
You can copy content of cell(s) to another cell(s). To copy cell contents in Calc, the steps are: 
 
1. Select the cell(s) that contain(s) the data you want to copy. 
2. Select Copy option from the Edit menu. 
Or 
Click the Copy button on the Standard bar. (Fig 8) 
Or 
Press CTRL + C to copy the data. 
3. Click on the cell(s) where you want to paste the data. 
4. Select Paste option from the Edit menu. 
Or 
Click the Paste button on the Standard bar. 
Or 
Press CTRL + V. 

 

1.6.3 Moving Cell Contents 
 
To move cell contents from one cell to another in Calc, the steps are: 
1. Select the cell that contains the data you want to cut. 
2. Select Cut option from the Edit menu. 
Or 
Click the Cut button on the Standard bar. 
Or 
Press CTRL + X to cut the data. 

 

 

Fig 8 Standard bar 

Let’s Try 
 
Start OpenOfficeCalc and create a new worksheet. Now, try the following: 
 

1. Select cell B3. 
2. Select the range of cells from A1 to D3. 
3. Select the range of cells from C5 to F5. 
4. Select multiple range of cells B4:D7 and C4:F8. 
5. Select row 5. 
6. Select row 3 and 8. 
7. Select column D. 
8. Select column B and G. 

 
 

Worksheet 
 

1. By default, how many worksheets are there in a Calc workbook? ____________ 
2. How are rows numbered in Calc? ________________ 
3. Name the column after column Z. ________________ 
4. What is the address of the cell formed by the intersection of 3rd column 5th row? 

____ 
5. Name the cells in the range A2:B5. ________________________________ 
6. How can you select entire worksheet using keyboard? _________________ 
7. How can you select entire column number B? _______________________________ 
8. Which key will you press if you want to select multiple ranges of cells? __________ 
9. Name the column after BZ? ___________ 
10.  What is the extension of a file saved in Calc? _____________ 
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3. Click on the cell where you want to paste the data. 
4. Select Paste option from the Edit menu. 
Or 
Click the Paste button on the Standard bar. 
Or 
Press CTRL + V. 
 

1.6.4 Inserting and Deleting Cells 
 
To insert cells, the steps are: 
 
1. Select the range of cells where you want to insert a block of cells. 
2. Select Cells option from the Insert menu. 
3. The Insert Cells dialog box appears.  
4. Select the appropriate option and click OK. 
 
To delete cells, the steps are: 
 
1. Select the range of cells where you want to delete a block of cells. 
2. Select Delete Cells option from the Edit menu.  
3. The Delete Cells dialog box appears.  
4. Select the appropriate option and click OK. 
 

1.6.5 Inserting Rows and Columns 
 
The steps to insert rows are: 
1. Select the row where you want to insert a new row. 
2. Select Rows option from the Insert menu. 
Or 
Right-click the row header and select Insert Rows in the shortcut menu. 
 
A new row is inserted above the selected/highlighted row.  
Cells in the new row are formatted similar to the corresponding cells in the row before which the new 
row is inserted. 
Multiple rows can be inserted at once by selecting multiple rows using theCTRL key or by dragging the 
mouse while holding down the left mouse button. 
 
To insert columns, the steps are: 
1. Select the column where you want to insert a new column. 
2. Select Columns option from the Insert menu. 
Or 
Right-click the column header and select Insert Columns in the shortcutmenu.  
 
When you insert a new column, it is inserted to the left of the selected/highlighted column. Cells in 
the new column are formatted similar to the corresponding cells in the column to the left of which the 
new column or row is inserted. 
Multiple columns can be inserted at once by selecting multiple columns using theCTRL key or by 
dragging the mouse while holding down the left mouse button. 

1.6.6 Deleting Rows and Columns 
 
To delete rows, the steps are: 
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1. Select the row to be deleted. 
2. Right-click on the selected row header. 
3. Select Delete Rows option in the shortcut menu.  
To delete multiple rows, select them using the CTRL key, or by dragging the mouse while holding the 
left mouse button. 
 
To delete columns, the steps are: 
1. Select the column to be deleted. 
2. Right-click on the selected column header. 
3. Select Delete Columns in the shortcut menu. 
To delete multiple columns, select them using the CTRL key, or by dragging the mouse while holding 
the left mouse button. 
 
Deleting Content 
Instead of deleting a row or column, you may want to delete the contents of the cells but keep the 
empty row or column. This can be done in the following manner: 
1. Select the cell(s), the contents of which you want to delete. 
2. Press the DELETE key. 
Or 
Select Delete Contents option of Edit menu. 
3. The Delete Contents dialog box appears. 
3. Check the boxes of the kind of data you want to delete (e.g., checking Formats will remove the 
formatting changes such as bold, italics, font colors, and borders). 
4. Click OK. 
 

1.6.7 Changing Row Height and Column Width 
 
You can change the row height in a Calc worksheet in any of the following ways: 
 
• Drag the divider below the row (Fig 9). 
• To fit the row height to the cell contents, double-click the divider. 
• Select Format ➢Row ➢Height. The Row Height dialog box appears (Fig. 10). Enter the value for row 
height in the Height spinbox. Click Ok button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Fig 9 Changing row height 

 

Fig. 10 Row Height dialog box 
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Changing Column Width 
 
You can change the column width in a Calc worksheet in any of the 
following ways: 
• Drag the divider to the right of the column header (Fig 11). 
 
2• To fit the column width to the cell contents, double-click the 
divider. 
• To change the column width, select Format ➢Column ➢Width.  
The Column Width dialog box appears. Enter the value for column  
width in the Width spinbox. Click Ok button. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.7 FILTER AND SORTING 

1.7.1 Filtering Data 
 
Filtering is a quick and easy way to find and work with selected data based on the criteria you specify. 
The filter feature selectively blocks out the data you do not want to see and displays only the rows or 
columns that meet the conditions or criteria you specify. Sorting rearranges the range of cells but 
filtering only hides temporarily the rows/columns you do not want. 
 
Different ways in which filtering can be done in Calc are: 

• AutoFilter 

• Standard Filter 
 
 

Fig 11 Changing column width 

Let’s Try 
 

1. Create the following worksheet. 

 
2. Insert a column after column D. 
3. Move the marks of Maths in the newly inserted column. 
4. Insert a new row after row 5. 
5. Insert the following details in the new row 

1105   Tiya  69   64    59   54 
6. Change the row height of all the rows. 
7. Change the column width of columns A to F. 
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AutoFilter 
 
To apply AutoFilter in a worksheet, the steps are: 

1. Select cell, say, A1. 
2. Select Data  ➢  Filter ➢  AutoFilter.  
3. A drop-down menu arrows appear in each column heading (Fig 12). 
4. Click the drop-down menu arrow for Total Sales and select an item (Fig 13).  
5. Only those rows whose contents meet the filter criteria are displayed.   

a. To display all the records again, select the All option in the filter drop-down menu. 
b. Select Top 10 to display the highest 10 values. 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

  

 

Standard Filter 

 
To apply standard filter in your worksheet, the steps are: 
1. Select  Data➢  Filter ➢  Standard Filter..  
2. The Standard Filter dialog box appears (Fig. 14).  
a. You can use the dialog box to connect multiple conditions with either a logical AND or a logical OR 
operator. 
3. Select the options in the Standard Filter dialog box. The records with Total Sales greater than 
4000 will be displayed (Fig. 15). 

 

 
 
Fig. 14 Standard Filter dialog box 
 
To remove the filter,  

1. Select Data ➢Filter ➢Remove Filter. 
 

 

Fig. 12 Drop-down menu arrows 
in column Headings 

 

Fig. 13 Drop-down menu for Total 
 

 

Fig. 15 Rows after applying 
Standard Filter 
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To hide the filter,  

1. Select Data ➢Filter ➢Hide AutoFilter. 
 
To remove the filter from column headings,  

1. Select Data ➢Filter ➢AutoFilter. 

 

1.7.2 Sorting Data 
Once you have entered data and applied relevant formulas in a worksheet, you can arrange the data 
in ascending or descending order. This is called sorting of data. 
 
Sorting on numerical and textual values is a one of the main features of any spreadsheet software. In 
Calc, sorting can be done in the following manner. 
 
Sorting on One Column 

1. Enter data in a worksheet (Fig. 16).  
2. Select any cell, say C1. 
3. Click the Sort option from the Data menu (Fig. 17) 

 

 
Fig. 16 Data in worksheet 

 

3. The Sort dialog box appears (Fig. 18). Notice that column Marks appears 
under Sort by section. 
4. Select the Descending option under Sort by and click OK. 
5. The data in column Marks is sorted in descending order.(Fig 19) 

 

 

 

 

 

 

 

 

 

 

 
 
 
You can also sort the data on one column is by using the sorting icons on the Standard bar.  
On the Standard bar, click (Fig 20) 

 

Fig. 17 Sort option in the Data menu 
 

 

Fig 19 Data arranges in 

descending order of Marks 
 Fig 18 Sort dialog box 
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• The Sort Ascending button to sort the data in ascending order. 
• The Sort Descending button to sort the data in descending order. 
 

 

 

 

 
 

Fig 20 Sort buttons on Standard bar 

 
Sorting on Multiple Columns 
You can sort the data on multiple columns.  

1. Consider the following worksheet. (Fig 21) 
2. Select cell, say C1. 
3. Select Sort option from Data menu. 
4. The Sort dialog box appears. 
5. The Sort Criteria tab on the Sort dialog box  

has options to sort the data on multiple columns. 
6. Select the options as shown in Figure 22.  
7. The data is sorted in descending order of column  

Total Sale, and where total sale is same, sorting  
is done in ascending order of column  
Salesman Name. (Fig 23) 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sort 

Ascending 

Sort 

Descending 

 
Fig 21 Worksheet 
 

 

Fig. 22 Multiple columns selected in the Sort 
dialog box 

 
 

 

Fig 23 Data sorted on multiple 
columns 
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1.8 FORMULAS AND FUNCTIONS 
The most important feature of Spreadsheet software is that you can perform arithmetic operations 
on the data in a worksheet.  
 

1.8.1 Formulas 
 
Formulae are used to calculate results through arithmetic operations.  
 
A formula in Calc always starts with an equal to (=) sign. If you forget to put = sign before the formula, 
it will be treated as text and no calculation will be performed. Also, you should not write anything 
before the = sign. Again it will be treated as text and no calculation will be performed. 
 
The data in a formula consists of one or a combination of the following: 
 
Value Numeric (e.g., 45) or string (e.g., “Smiling”) 
Cell Address B4, A2:C6 
Function SUM, AVERAGE, MIN, MAX, etc. 
Operator +, -, *, /, >, =, etc. 
Parenthesis To control the left to right order of precedence in a formula (e.g., = (B2*B3)*2) 

 
<A>Numeric Formulae 
In numeric formulae, you have to make use of operators. The results are calculated based on the 
order of precedence of the operators. 
 
<B>Mathematical Operators Used in Formulae 
The mathematical operators used in Calc and their order of evaluation in formulae is given below: 
 
Operation   Operator  Order of evaluation  Formula Result 
Exponent    ^   1    = 2 ^ 3   8 
Multiplication    *   2    = 3 * 5   15 
Division     /   2    = 9/ 3  3 
Addition    +   3    = 12 + 15  27 
Subtraction    -   3    = 18 - 15  3 

 
Order of evaluation 

1. Any operation contained within brackets will be carried out first 

Lets Try! 
 

1. Create the following worksheet and perform the following operations: 

 
a. Sort the table in ascending order of height. 
b. Filter the data to view only those rows where height is more than 8500 m. 
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2. Then any exponent.  
3. Then follow division and multiplication operations. Multiplication and division are given 

equal importance. They are carried out in the order they occur in the formula, from left to 
right. Whichever appears first in the formula is carried out first.  

4. After that, addition and subtraction operations are given equal importance. They are also 
carried out in the order they occur in the formula, from left to right. 

Following are some examples of how Calc evaluates formulae. 
Formula    Output 
= (3 + 7) * 2    20 
= 4 * 3 + 5    17 
= 3 + 3 ^ 2    12 
= 5 + 3 * 4 – 2    15 
= 6 + 14/2 * 3 - 4   23 
 
<C>Error Results 
Sometimes a formula displays an error result rather than a proper value. This happens when the 
formula or data has a problem and Calc cannot evaluate it. 
 
Some common errors are shown below: 
 
Error    Reason 
#####    The column is not wide enough to display the value. 
#DIV/0!   The formula contains an invalid operation, i.e., division by zero. 
#VALUE!   The formula has invalid argument, e.g., text in a cell where numeric value is 
required. 
 
<D>Text Formulae 
A text string or a text value is a sequence of characters. You can join two strings together. This is 
called concatenation. We use the ampersand (&) character to concatenate strings. 
For example, if you type = “Keep” &“ “& “Smiling” in a cell and press ENTER, you will see the result 
as Keep Smiling. 
 
You cannot do operations such as subtraction, multiplication, and division on strings.  
 
<E>Cell and Range References 
A cell reference identifies a cell or a range of cells. Each cell in the worksheet has a unique address 
formed by the combination of its intersecting row and column. When a cell address is referred to in 
a formula, it is called cell referencing.  
Consider the following examples: 
 
Cell or a Range of Cells             Reference 
The cell in column B and row 4       B4 
All cells in row 5        5:5 
All cells in rows 5 through 9       5:9 
All cells in column B        B:B 
The range of cells in column F and rows 1 through 7    F1:F7 
The range of cells in row 5 and columns C through E    C5:E5 
All cells in columns C through G       C:G 
The range of cells in columns B through G and rows 4 through 8   B4:G8 
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<F>Entering A Formula 
All formulae in OpenOfficeCalc begin with an equal to (=) sign. A formula can contain number, text, 
arithmetic operators (+, -, *, /), or functions. The order of precedence is already discussed. 
 
To  enter a formula: 

1. Select the cell and enter the formula directly in the cell or in the Formula Bar. 
2. Press the Enter key. 
3. The cell will show the result of the formula and the formula itself. You can see the formula in 

the Formula bar when the cell is selected. 

 

 
Consider the following worksheet.(Fig 24) 
 

 
 
                                                          Fig 24 Worksheet 

 
 
To find the total marks: 

1. Select cell D3. 
2. Type the formula =B3+C3. 
3. To copy this formula in 

other cells: 
a. Select cell D3. 
b. Click the AutoFill handle 

and drag till  
cell D6. (Fig 25) 

c. The formula copied in cell 
D4 will be =B4+C4. 

d. The formula copied in cell 
D5 will be =B5+C5. 

e. The formula copied in cell 
D6 will be =B6+C6. 

 

 

 

 

 

 

Fig 25 Copying formula 
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Let’s Try 
 

1. Create the following worksheet. 
 

 
 

2. Now, type the formula =45+67+77 in cell D2. Press Enter key. 
3. Now change the value 88 in cell C2.  
4. Did you notice any change in the cell D2? 
5. Now, type the formula =A2+B2+C2 in cell D2 and press Enter key. 
6. Notice the result in cell D2. 
7. Now, change the value in cell A2 to 89. 
8. Notice the change in cell D2.  
9. Notice the benefit of giving cell address in a formulae. 

 

Let’s Try 
 
Create the following worksheet in Calc. 
 

 
 

1. Write the formula to calculate area of a rectangle in cell C3 (=A3*B3). Then press Enter key. 
2. To copy the formula to cells C4 and C5: 

a. Select cell C3. 
b. Click and drag the AutoFill handle to cells C4 and C5. 

3. Write the formula to calculate perimeter of rectangle in cells D3 (=2*(A3+B3)). Then press 
the Enter key. 

4. Now, copy the formula in cell D3 to D4 and D5. 
5. Save the worksheet as ‘rectangle’. 

 
 

Let’s Try 
 

1. Open the file ‘rectangle’. 
2. Change the values of length and breadth in cells A3, A4,B3 and B4. 
3. Observe the change in the results in cells C3, C4, D3 and D4. 
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1.8.2 Using Functions to do calculations 
 
Functions are predefined formulae that perform calculations using specific values called arguments. 
 
The format of writing any function in Calc is: 
=function_name(Argument1;Argument2; Argument3;…..) 
 
Arguments These are the values passed to a function so that the function carries out the intended 
calculation or manipulation to give results. Arguments can be constants, formulae, or function. 
 
<A>SUM 
You have already learnt how to find total using the formula. You can also obtain the sum of the values 
in a range of cells by: 
• Clicking the Sum button on the Formula bar (Fig 26) 
 
• Using the SUM() function 
 
SUM function is used to find total of numbers in a range of cells. 
For example: 

 
Formula                Result 
=SUM(5;6;12)             23 
=SUM(A1;B1;C1) where A1, B1                   49 
 and C1 contain the values 12, 23 
 and 14 respectively  

 

 

 

 

SUM button 

      Fig 26 Formula bar 
 

 
Let’s Try 

 
Create the following worksheet and perform the following operations 
 

 
 

a. Filter the records according to the following condition: 
b. Add another column at the end with heading ‘Total marks’ 
c. Calculate total marks for each student. 
d. Now, arrange the data in descending order of Total marks. 
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Let us consider an example. 

1. Consider the worksheet shown in Figure 27. 

 
Fig 27 Creating a worksheet 
 

2. Select the cell D2. 
3. Click the Sum button on the Formula bar. Notice it will select the range A2:C2. (Fig 28). 
4. Select the correct range B2:D2 or type the correct range (Fig 29). 

 

 
 
                           Fig 29 
 
 

5. Press ENTER (Fig. 30) to perform the operation.  
The sum of the range B2:C2 will appear in  
cell D2. 

6. Select cell D2 and using the AutoFill handle,  
drag the formula through D7. The  
respective sums will appear in the respective  
cells.(Fig 31) 

 

 
<B>AVERAGE Function 
Average function is used to find the average of numbers in a range of cell. 
For example: 
Formula      Result 
=AVERAGE(3;6;9)     6 
=AVERAGE(A1;B1;C1)   5 
 where A1, B1 and C1 contain the 
 values 4, 5 and 6 respectively  

 

Fig 28 
 

 

               Fig 30 
 

 

Fig 31 
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<C>COUNT Function 
The COUNT function is used to count the number of numeric values in a range of cells. 
For example: 
 
Formula      Result 
=COUNT(5;8;14;19)     4 
=COUNT(A1:A10) 
 
<D>MAX Function 
The MAX function is used to find the maximum of numbers in a given range of cells. 
For example, 
 
Formula      Result 
 
=MAX(74;102;134)     134 
=MAX(A1;B1;C1)  
Or 
=MAX (A1:C1)    6 
 where A1, B1 and C1 contain the 
 values 4, 5 and 6 respectively 
 
<E>MIN Function 
The MIN function is used to find the minimum of values in the given range of cells. 
For example; 
Formula      Result 
 
=MIN(74;102;134)     74 
=MIN(A1;B1;C1)  
Or 
=MIN (A1:C1)     4 
 where A1, B1 and C1 contain the 
 values 4, 5 and 6 respectively 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Worksheet 
 

1. Every formula in Calc starts with which symbol? _____________ 
2. The formula in cell B6 is ‘=MIN(B1:B5)’. When copied to C6, the formula changes to 

________________. 
2. If A1:A4 contains the numbers 11, 13, 15, 17, the formula =AVERAGE(A1:A4) in cell 

A5 will display ______________. 
3. Cell B1 contains 12 and C1 contains 8. What will be the content of cell D1, if the 

formula =B1*C1/2 is entered in cell C1?  ___________________ 
4. The contents of cell B2, C2, D2, and E2 are 13, 15, 17, 19 respectively. What will be 

the value in cell E2, if the formula =MAX(B2:E2) is entered in cell E2? ___________ 
5. What is the difference between MAX and MIN functions in Calc?  

____________________________________________   
____________________________________________ 
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1.9 PASSWORD PROTECTION 
In OpenOffice Calc, you can protect your spreadsheet with a password. To protect your data, you can 

either assign a password to a sheet or Calc document. This can be done using Tools menu and aslo 

while saving the document. 

1.9.1 Using Tools menu 
The steps to protect worksheet or Calc document using option of Tools menu are: 

1. Select Tools menu  ➢ Protect document   Choose whether to protect Sheet or Document. 

(Fig 32 ). 

2. If you select Sheet, the Protect Sheet dialog box appears. (Fig 33). 

 

 

 

 

 

 

 

 

 

If you select Document, the protect Document dialog box appears. 

3. Type the password in Password text box. Again type the password in Confirm text box. Note 

that the password is case sensitive. 

4. Click OK button. 

 

 

 

 

 

1.9.2 Protecting Calc doument while Saving 

You can also protect your spreadsheet with a password while saving the document. The steps are: 

1. Select Save As option from File menu. 

2. The Save As dialog box appears. Select the drive and the folder where you want to save the 

file. 

Undoing Password Protection 

To remove a password, open the 

document, then save without 

password 

Tip 

Rules to select a password: 

• Length of 8 or more characters 

• Mix of lowercase and uppercase letters, 

numbers and special characters 

 

Fig 32  Tools menu 

 

 

Fig 33  Protect Sheet dialog box 
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3. Select Save with password check box. (Fig 34) 

 

 

 

 

 

 

 

 

 

 

4. Click Save button. 

5. The Set Password dialog box appears. (Fig 35)  

6. Enter the password to open. Again type the 

password in  

Confirm password text box. 

7. Next, click on  More options. The dialog box expands  

as shown below in figure 36. 

 

8. Here, you can give file sharing password. You can 

select 

 the check box of Open file read-only option, if you want 

the recipient to only read the file and make no changes. 

 You can also enter password to allow editing. 

9. Click OK button. 

 

1.10 PRINTING A SPREADSHEET 
Select  File➢ Page Preview to view a worksheet so as to  
get an idea of how it will look when printed. 
 
or  
 
Click the Page Preview button on the Standard bar (Fig 37). 
 

 

 

 

 
Fig 37 

 

 

Page Preview Print button 

 

Fig 34 Save As dialog box 

 

 

Fig 35 Set Password dialog box 

 

Fig 34 Set Password dialog box 

 

Fig 36 
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 To print a worksheet, the steps are: 
1. Click File ➢Print. 
2. The Print dialog box will appear (Fig. 38). 
3. Select the printer, the range to be printed, and the number of copies. 
4. Click the Print button.  

 
To quickly print without getting the Print dialog box, click the Print button on the Standard bar. (Fig 
37) 

 
 
Fig. 38 Print dialog box 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Lets Try it 
 

4. Create the following worksheet and perform calculations using functions in Calc. 
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Lets Try it 

 

1. Create the following worksheet and calculate total and percentage 

for each student. 

 

 
 

 

2. Create the following worksheet. Calculate area and perimeter of 

square. 

 
 

 

3. Create the following worksheet. Calculate area and perimeter of 

rectangle. 
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1.11 SAVING A SPREADSHEET IN VARIOUS FORMATS 
We have already learnt how to save a document in OpenOffice Calc. The default extension of a Calc 

file is .ods. 

1.11.1 Saving in Microsoft Excel Format 
If you want to save the file in the Microsoft Excel file format, then do the following while saving: 

1. Select Save As option from the File emnu. 

2. The Save As dialog box appears. (Fig 39) 

3. Change the Save as type to Microsoft Excel 97/2000/XP(.xls). 

4. Delect the drive and the folder where you want to save the file. 

5. Type the filename and clcik Save button. 

 

Fig 39 Save AS dialog box 

 

Worksheet 
 

1. How will you refer to a cell in column B and row 3? 
2. How will you refer to range of cells in row 5? 
3. How will you refer to range of cells in column D through F and rows 3 through 8? 
4. Write mathematical operator for the following operation: 

a. Multiplication 
b. Division 

5. If formula in cell C3 is =A3+B3, what formula will be copied in cell D3? 
6. How will you write a function to find average of numbers 5, 12, and 17? 
7. Name the function used to find total of numbers in the range of cells A1 to A10. 
8. Name the menu used to print the document. 
9. What error will you get if the column is not wide enough to display the value? 
10. What happens if you write the formula =45/0 in cell A1? 
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1.11.2 Saving in PDF format 

Sometimes, when saving a document, you do not want the recipient to modify it. The safest way is 

to save the document in PDF (Portable Document Format) format and then share it. The simplest 

way to do this is: 

1. Click on the Export Directly as PDF icon         on the Standard bar. This will export the 

entire document using the default PDF settings. 

2. The Export dialog box appears. 

3. Select the drive and the folder where you want to save the file. 

4. Type the file name and clik OK button. 
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All entrepreneurs are different but there are some characteristics and qualities that have been 
observed to be common among successful entrepreneurs over the years. Along with the qualities and 
traits, the motivation to choose the path of entrepreneurship as well as the journey to success is also 
different for each entrepreneur. However, one thing that drives all entrepreneurs is the sense of 
purpose behind their venture as well as willingness to take the leap and implement their ideas. More 
than anything, most entrepreneurs follow a basic process of entrepreneurship to kick start their 
ventures. 
 
 
 
 

To launch a new venture, just recognizing a need or having an idea of how to fill the gap or need, are 
not strong enough basis. Entrepreneurs must be aware of the barriers to entry of the industry before 
they create a business plan, borrow capital or create the product. In depth market and industry 
analysis can make an entrepreneur aware of barriers to entry.  

2.1 Unsupportive business environment: Business environment and ecosystem can be 

unsupportive due to cartelization, government regulations, corruption, bribery, bureaucracy etc. This 
can serve as a barrier to entrepreneurship as a supportive business environment is needed for the 
business to thrive. For example, Russia lacks rule of law, allows rampant corruption and bribing, 
enforces regulations inconsistently, allows regulatory authorities and inspectors to act in a predatory 
nature. All these factors make the business environment in Russia highly unsupportive.  

2.2 Market entry regulations: Taxation, 

governmental rules, licensing mandates, 
environmental regulations, lending needs 
can all be barriers towards venture creation. 
In many industries, licensing is required for 
creating a new firm and entering the market. 
Tax disadvantages, lack of property rights 
and predatory tax behaviour also serve as 
barriers for market entry.  

2.3 Shortage of capital: Capital or funding 
is required for any business to develop 

products/services, organize factors of production, train employees, market and sell etc. In many cases, 
especially in developing countries, shortage of funds or difficulty in finding the right investor or lender 
to start and run an enterprise, serves as a huge barrier to entrepreneurship.  

2.4 Skilled workforce challenges: Employees form the heart of the business. One of the most 

crucial but overlooked tasks in a business is to build a skilled employee asset base. Lack of appropriate 

     Class XII                Entrepreneurial Skills 

1. Introduction 

2. Barriers to Becoming an Entrepreneur 
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practical and technical skills, lack of qualified employees, employee turnover, changes in labour laws, 
increase in employee’s financial expectation etc. create barriers towards entrepreneurship and 
smooth functioning of the business.  

2.5 Lack of Entrepreneurial Mindset & Training: Entrepreneurial mindset about having 

entrepreneurial skills, willingness to initiate new ventures, motivation to persist in challenging times 
and adapting to change. If this mindset is discouraged in any manner in any culture, then that itself is 
a barrier to entrepreneurship. Similarly, lack of entrepreneurship or related training and education 
can be a barrier in success of entrepreneurial activity. Training in managerial, technical and 
entrepreneurial skills is beneficial and important for budding entrepreneurs and early employees.  

2.6 Risk Aversion: Entrepreneurs have to decide whether to take action so they don’t miss the boat, 

while knowing that hasty action may cause them to sink the boat. Risk is a part of every business and 
if people from a country/region/culture are risk averse, then that can be a barrier to entrepreneurship. 
As entrepreneurs, it is important to take the plunge, accept failure, take risks etc.  

2.7 Fear as a barrier  

Fear is defined as an unpleasant feeling triggered 
by the perception of danger, real or imagined. In 
human psychology, fear is seen as an emotion as 
feeling fear helps to avoid calamity but at the 
same time it can also hold one back. In the 
process of entrepreneurship, fears are like 
obstacles. It is important for an entrepreneur to 
acknowledge his/her fears, confront them and 
find ways to move beyond them.  Some common 
fears seen in entrepreneurs are as follows: 
 

2.7.1 Fear of failure: The fear of failure works 
on the presumption that everything could go 
wrong in the business. The best way to overcome 
this fear is to accept that failure is possible, look 
on the positive side and consider added value 
that comes with every failure, in the form of 
strength, courage, wisdom and knowledge.  
 

2.7.2 Fear of the unknown: Entrepreneurial journey is full of ambiguities and uncertainties. It is 
common to avoid uncertainties and unknown because we fear change. Many people are afraid of 
losing control and being unable to manage potential outcomes. The best way to overcome this fear is 
to recognize that life is full of uncertainties and that there is no guarantee that plans will work. Hence, 
change must be accepted.  
 

2.7.3 Fear of not being an expert: This fear can become a barrier for many budding entrepreneurs. 
It is the feeling of not knowing enough about your industry or business or product. Many 
entrepreneurs are not considered experts in their line of business, but still they make important 
decisions and solve issues everyday within their industry. The best way to overcome this fear is to 
constantly and continuously learn about what one does not know.  
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2.7.4 Fear of being pushed into uncomfortable situations: Uncomfortable situations are those 
that arouse a feeling of fear in you. For example, many people are scared of public speaking and 
consider that to be a highly uncomfortable situation. However, by trying and practicing, one can 
become comfortable by pushing themselves outside their comfort zone. By preparing oneself to take 
on to the challenge and by taking smaller steps to work towards it, fearful situations can also start to 
feel comfortable.  
 

2.7.5 Fear of risk taking: Risk can be dangerous and unmitigated or thoughtful and calculated risk. 
Dangerous risk is more like gambling while calculated risk is more like strategy. The best way to 
overcome this fear is to move incrementally towards the goal, carefully assess the level of investment 
and then take the risk.  
 
 
 
 
Entrepreneurial behavior requires certain knowledge, skills or personality profile. Generally, it is called 
entrepreneurial competence or traits. A competence may be defined as underlying characteristics of 
a person which results in effective and/or superior performance in a job. Entrepreneurial 
competencies play a key role in the success of an entrepreneur and in achievement of entrepreneurial 
goals. 

 
3.1 Common Entrepreneurial Competencies 
 
In a study conducted by David C. McClelland, a reputed behavioural scientist, and Entrepreneurship 
Development Institute of India (EDII), certain competencies were identified that were found in 
successful entrepreneurs who exhibited superior performance. These competencies can be developed 
through training, experience and guidance in a budding entrepreneur. Some of these competencies 
include: 
 

3.1.1. Taking 
Initiative: It is about 
making the first move 
towards setting up of an 
enterprise and taking 
action.  
 

3.1.2. Seeking and 
Acting on 
Opportunity: An 
entrepreneur is always on 
the look-out or searching 
for opportunity and is 
ready to exploit it in the 
best interests of the 
enterprise.  
  

3.1.3. Persistence: An entrepreneur is never disheartened by failures and keeps trying, adapting and 

iterating to overcome obstacles that come in the way of achieving goals. 
  

3. Entrepreneurial Competencies 

https://www.entrepreneur.com/article/277330
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3.1.4. Information Seeking: A successful entrepreneur always keeps his/her eyes and ears open and 
is receptive to new ideas which can help in realizing his goals. He/she is always open to consult with 
experts and mentors to get the right guidance and advice. 
  

3. 1.5. Concern for High Quality: Successful entrepreneurs are seen to be not satisfied with 
moderate or average performance. They set high quality standards for themselves and then put in 
their best for achieving these standards. They believe in excellence, which is reflected in everything 
they do. 
  

3.1.6. Commitment: Entrepreneurs exhibit high level of commitment towards their work and 

decisions. For an entrepreneur to succeed, they have to stay committed to their venture and their 
goal. 
  

3.1.7. Concern for Efficiency: Many entrepreneurs are always keen to devise new methods aimed 
at promoting efficiency. They try and create new methods that aim at making working easier, simpler, 
better, and economical. 
  
3.1.8. Systematic Planning: Successful entrepreneurs decide future course of action keeping in 
mind the goals to be achieved. They believe in developing relevant and realistic plans and ensure 
proper execution of the same in pursuit of running a successful enterprise. 
  

3.1.9. Problem Solving: An entrepreneur takes each problem as a challenge and put in best for 

finding out the most appropriate solution for the same. He/she will first of all understand the problem 
and then evolve appropriate strategy dealing with the same. 
  

3.1.10. Self-confidence: Entrepreneurs are not cowed down by difficulties as they believe in their 
own abilities and strengths. They have full faith in their knowledge, skill and competence and have the 
confidence to handle future uncertainties. 
  

3.1.11. Assertiveness: An assertive person knows what to say, when to say, how to say and whom 
to say. Entrepreneurs exhibit assertiveness in situations around decision making to ensure that 
interests of the organization are aligned with decisions and actions of the entrepreneur and its team. 
  

3.1.12. Persuasiveness and Influencing Others: Entrepreneurs have to persuade different cohorts 

of people at different stages, such as employees, customers, clients, suppliers etc. Through sound 
opinions and logical reasoning, an entrepreneur manages to convince others about what he/she 
wants.  

  
3.1.13. Effective Strategist: A successful entrepreneur possesses the ability to formulate relevant 

strategies, aimed at safeguarding or promoting the organization’s interests and goals. Strategy may 
be with respect to facing future uncertainties or challenges posed by competitors etc. 
  

3.1.14. Effective Monitoring: Entrepreneurs monitor that everything is carried out in their 
organizations as per their decisions but at the same time give some flexibility to the employees. They 
ensure regular monitoring of the working so that the goals of the organization are achieved in best 
possible manner. 
  

3.1.15. Concern for Employees Welfare: Dedicated, committed and loyal employees directly 
influence the performance of the organization. A successful entrepreneur tries to promotes interests 
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of employees, helps in solving problems confronting employees and generates the feeling that there 
is interdependence of the interest of employees and the management. 

3.1.16. Adaptability: Adaptability refers to the capacity to adjust one’s thoughts and behaviours in 

order to effectively respond to uncertainty, new information, or changed circumstances. In business, 
adaptability becomes a survival skill as the nature of businesses is dynamic. Uncertainty around 
globalization, new technologies, market trends, etc., poses a tremendous challenge for applying the 
right business strategy. Entrepreneurs learn to disrupt, pay the price and bring change. It is impossible 
to accomplish this without developing the skill of adaptability. 

3.1.17. Decision Making: One of the most important traits of being an entrepreneur is being able 
to take decisions that more often than not, decide the fate of the company. At the helm of the 
company, entrepreneurs often have to take that one decision at the right time which can define the 
future of their company. And then they also have to quickly act upon their decisions. 
 

3.1.18. Goal Setting: Goal setting refers to establishing short or long-term objectives, usually along 
with incorporating deadlines and quantifiable measures to indicate if they have been achieved. For a 
business, the ultimate goal is to make profit. For a social enterprise, the ultimate goal might be to 
sustain itself and create the impact that it aims to. Entrepreneurs set various goals with different 
timelines. Each action and decision is taken to achieve a certain goal. 
 

3.1.19. Team Building: Team building is any action or method that brings a group of individuals 
together and motivates them to work cooperatively as a team. It refers to the various activities 
undertaken to motivate the team members and increase the overall performance of the team. Teams 
are formed when individuals with a common interest come together on a common platform to achieve 
a predefined target. The main goals of team-building are to improve productivity and motivation. 
 

3.1.20. Interpersonal Skills: For smooth functioning of a team, each member must be consistent 
and clear in their communications and interpersonal skills. Clear communication helps everyone in the 
team to understand what’s expected and how it’s measured. It must also be ensured that no member 
offends the other.  
 

3.1.21. Creativity: Creativity is a process of continually improving ideas and solutions by making 
gradual alterations and refinements. Entrepreneurs exhibit creativity by applying the process of design 
thinking, thinking of alternatives, trying unconventional ways to do things and continuously improvise 
and iterate. 
 

3.1.22. Risk Taking: Entrepreneurs take enough risk but it is a calculated risk. They use risk 

management principles to assess the loss and return of the risk.  
 

3.1.23. Perseverance: It is important to be perseverant and patient and ready to continue even if 
the first battle is lost. Entrepreneurs need to stay put, be patient and believe in their vision. It is only 
by trying different things and ways to do them, that a solution can be found.  
 

3.1.24. Negotiation skills: Negotiation skills for entrepreneurs are critically important to business 
success. There a number of scenarios where an entrepreneur's negotiation skills come into play such 
as supplier relations, customer sales, employee hiring, securing investors etc.  
 

http://www.entrepreneurshipinabox.com/13072/risk-management-guide-business-risk/
http://www.entrepreneurshipinabox.com/13072/risk-management-guide-business-risk/
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3.1.25. Organizational skills: Organizational skills for entrepreneurs are not just about structuring 
and prioritizing their daily work, but mainly about managing teams, delegating, setting targets, 
continually reviewing and leading and motivating the people around them.  
 

3.1.26. Stress management: Entrepreneurs have a hectic work life and thus, it is important for them 
to manage and handle stress. This refers to taking systematic brakes, maintaining work-life balance, 
setting achievable goals, connecting with other like-minded entrepreneurs etc.  
 

3.1.27. Valuing service and diversity: Diversity is about how an organization treats its people 

authentically down to the roots of its business model.  It is key for an entrepreneur to remember that 
a person working for him/her is actually providing their service. At the same time, people of all 
cultures, race, religion, gender etc. have to be treated equally and with respect, such that they 
mutually flourish and grow together.  
 
 

3.2 Benefits of Entrepreneurial Competencies  
 

• Taking actions to implement your ideas. 

• Understanding the need or the problem your offering is fulfilling or solving. 

• Strategizing and planning the steps that need to be taken. 

• Preparing an action plan and timeline. 

• Networking with stakeholders. 

• Interacting with customers. 

• Gaining and analyzing insights. 

• Looking for alternatives and adjusting plans according to analysis and feedback. 

• Evaluating and calculating the risk involved. 

• Building and motivating a team. 

• Being patient and staying motivated to overcome and work around various obstacles. 

• Showing the value that the business is creating for stakeholders and customers. 

• Gaining the know-how of creating, building, launching, sustaining, managing and growing a 
business. 

Activity I – Self Reflection 

Self-reflect and check if you relate to the statements given below: 

I like to give myself challenges when I take on a new project. 
Where others see problems, I see possibilities. 
I do not worry about what others will think before doing something important. 
I am fairly curious and I am continually in search of discovery. 
I want to build something that will be recognized publicly. 
When I take on a project I have confidence that I will carry it out successfully. 
I feel that am capable of seeing many solutions to a problem. 
I always try to learn lessons from my failures. 
I am not afraid to take on initiatives. 
I manage my stress well in ambiguous and uncertain situations. 

After some self-reflection, consider the competencies of entrepreneurs given above. Self-evaluate 
yourself on these competencies by giving a rank number to each.  
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For example: 

Self-confidence – 1 
Commitment – 4 
Problem Solving – 6 

According to the above ranking, one thinks that self-confidence is their strongest competency. 
Commitment comes at the 4th rank and problem solving at the 6th. Thus, problem solving as a 
competency is weaker than commitment for the person in the example given above.  

___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 

 

Activity II - Taking Initiative 

Have you taken initiative towards anything? Consider the following statements to think about it: 

- Think about a time you went above and beyond what was expected of you. 
- Think about a situation when you were creative. What did you do? 
-  Can you remember a situation when you took responsibility for something and had negative 
consequences? What did you learn from it? 
- Have you ever noticed and raised issues in a project/activity/discussion? 
- Think about a time when you worked on a group project and made improvisations in it. 
 
Write a situation when you took initiative. Mention what you liked/disliked about it. Share your 
learnings (if any) from the experience.  
 
___________________________________________________________________ 
___________________________________________________________________ 
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___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
 

Activity III - Taking Initiative 

Are there any activities/ideas/events/projects etc. that you want to try and have not got the chance 
to?  

In the space given below, make a list of things you want to take an initiative for, in the next 1 to 5 
years. 

___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
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Activity IV – Information Seeking 
 
Read the situations below and write answers to the questions given below: 
 
- Who should the entrepreneur seek information from? 
- What information should the entrepreneur acquire? 
 
Simaya has started a company which makes bags and wallets using fish leather. Fish leather is made 
by using the waste material from the fishing industry. Simaya is trying to understand who her 
customers are. She is not sure if she should start selling the products online or supply to offline stores 
or do both. She does not know what will be the touch points where people could buy the products 
she is planning to design. She wonders what preferences and choices people would have. 
 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
Dhruv has started a brand that customizes kid’s shoes. While he has made sales on some online 
websites selling kids products, he is unable to make a sustainable profit. He is also looking for ways to 
raise some capital to start selling from his own website and retail store. 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
Janvi is thinking about starting a business that conducts training workshops for working professionals. 
She plans to teach business-related topics and develop employability skills through the workshops. 
However, Janvi does not know what kind of competition will be there. She wonders if she will be able 
to get enough customers to beat the competition in such a crowded space. 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
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Activity V – Goal Setting 

SMART Goals 
 
S.M.A.R.T. is an acronym for the 5 steps of specific, measurable, attainable, realistic, and timely goals. 
It’s a simple tool used by businesses to go beyond the realm of fuzzy goal- setting into an actionable 
plan for results.  
 
Specific: Great goals are well-defined and focused. The moment one focuses on a goal, the goal 
becomes a magnet, pulling resources towards it. The more focused one’s energies, the more power 
one generates. 
 
Measurable: A goal without a measurable outcome is like a sports competition without a scoreboard 
or scorekeeper. Numbers are an essential part of business. Concrete numbers should be put in the 
goals to know if one is on track.  
 
Attainable: A goal must be achievable. Far too often, small businesses can set goals beyond reach. No 
one has ever built a multi–crore business overnight. Venture capitalists and angel investors discard 
countless business plans of companies with outlandish goals.  
 
Realistic: Achievable business goals are based on the current conditions and realities of the business 
climate. One may desire to have the best year in business or increase revenue by 50%, but if a 
recession is looming and three new competitors open in the market, then the goals are not as per the 
realities of the market.  
 
Timely: Business goals and objectives just don’t get done when there's no time frame tied to the goal-
setting process. Every plan or project must follow a timeline. Whether the business goal is to increase 
revenue by 20% or find 5 new clients, a time-frame or deadline to accomplish the goal must be set. 
 
 

Let us do small exercises to understand SMART goals better.  
 
Specific: 
Look at the examples below. Underline the goals that are specific. 
 
Get in shape. 
I will go to the recreational centre Monday, Wednesday, and Friday at 6:00 a.m. and walk around the 
track for 30 minutes. 
Get good grades. 
I will sit at the table every day at 3:30 p.m. and work on assignments given that day in school until 
4:30. Upon completion, I will place the assignments in the correct folder, take to school and turn in 
before class starts. 
Get rich. 
I will save 25% of my paycheck every month and invest in mutual funds until I am 55 years old.  
 
Measurable: 
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The above examples give good indications.  Write in the measurable outcomes from the above 
examples of #2, #4, #6. 
 
#2.  ______________________________________________________________  
#4.  ______________________________________________________________ 
#6.  ______________________________________________________________ 
 
Attainable:  
Which of these goals seem attainable? 
Earn 10 times the money I make compared to this month. 
Exercise daily for one hour. 
Eat an apple a day. 
Watch television for all night but wake up early every morning.  
Live in Antarctica for a year, after I have lived in Mumbai all my life. 
 
Realistic: 
If I wanted to run a marathon and I haven’t done any training, which goal would better represent my 
reality? 
 
I will walk every day for 30 minutes for one week, jog for 30 minutes for two weeks, add five minutes 
to my work out every week until I reach 60 minutes and continue training for three months. 
I will run the marathon on Saturday. 
 
Timely:  
Give yourself a deadline. When you have an end date, you will finish your goal.  Look at the above 
examples (all of them). Write the goals that have a time frame. 
__________________________________________________________________________________
__________________________________________________________________________________
__________________________________________________________________________________
__________________________________________________________________________________
__________________________________________________________________________________
________________________________________ 
 
 

Activity VI – Goal Setting 

Write an academic or personal goal below in the SMART manner: 
 
S – My SPECIFIC Goal 
__________________________________________________________________ 
__________________________________________________________________ 
__________________________________________________________________ 
 
M – How will I MEASURE my progress?  
__________________________________________________________________ 
__________________________________________________________________ 
__________________________________________________________________ 
 
A – What ACTIONS must I take to accomplish this goal? 
__________________________________________________________________ 
__________________________________________________________________ 
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__________________________________________________________________ 
__________________________________________________________________ 
 
R – Is my goal REALISTIC and attainable? ____ Yes ____ No  
 
T – Is my goal TIMELY?  When will this goal be accomplished?  
______________________________________________________________________ 
______________________________________________________________________ 
______________________________________________________________________ 
 
 

Activity VII– Decision Making 

Decision Making…….. The Lunar Disaster 
 
 On April 11, 1970 astronauts James Lovell, John L. Swigert, and Fred W. Haise blasted off from 
Cape Kennedy aboard Apollo 13.  At 54 hours and 54 minutes into the mission a large explosion 
crippled the spacecraft.  Four days the attention of the world was riveted on the disabled spacecraft.  
Because of quick thinking and the use of computers, mission control was able to get the crippled 
spacecraft safely back to Earth. 
 
 In this activity, you are a member of the crew of a spaceship scheduled to rendezvous with 
the mother ship, located on the lighted surface of the moon.  Due to mechanical difficulties, your ship 
is forced to land on the dark side of the moon, 200 miles (~ 322 km) from the mother ship. During the 
emergency landing much of the equipment aboard was damaged and since survival depends on 
reaching the mother ship, only the most critical items must be chosen for the 200 mile trip.  Below is 
a list of 15 items left undamaged by the crash.  Rank each of these items in order of importance from 
1 the most important to 15 the least important. 
   

Here is some background information, which may be useful.  There is no atmosphere or water 
on the moon, and the moon has almost no magnetic field. A FM transmitter uses straight-line 
communication and has a range of less than 100 miles on the Earth, so on the moon the range would 
be considerably less.  The gravity on the moon is 1/6th that of the Earth.  The items below are in no 
particular order.  

 

Item 
My Ranking  |   (Individual score) Group ranking   |    (group score) 

Box of matches 
                      |                              | 

Food concentrate                       |                             | 

Nylon rope, 50 feet                       |                             | 

Parachute silk                       |                             | 

Portable heater                       |                             | 

Two 0.45 caliber pistols                       |                              | 

Dehydrated pet milk, One case                       |                             | 

Two 100-Pound oxygen tanks                       |                             | 

Star Map-Moon Constellations                       |                             | 
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Life raft                       |                             | 

Magnetic compass                       |                             |  

5 gallons of water                       |                             | 

Signal flares                       |                             | 

First-aid kits, injection needles                       |                              | 

Solar powered FM transmitter                       |                             | 

 
After ranking each item 1-15, get together with another student and re-rank the items remember 1 is 
the most important and 15 is the least important.  With your partner(s) AGREE on a ranking (Do not 
change your individual score) and place the number under group rank (each person in the group 
should have the same GROUP rank).  After completing both individual and group ranking your teacher 
will give you the actual ranking determined by NASA. 
 
To score subtract the difference between the number written with the actual number given by your 
teacher.  Place the difference in the column labeled score (Individual and group) 
 
After completing the scoring add up the numbers in each score column and place the total in the 
spaces below. 
 
Individual score _______________   Group score _________________              
 
Reflect on the decision-making process you followed. 
Discuss why the scores increased or decreased after working together.   
Discuss ways of thinking critically in the future. 
 
Note: The answer key of actual ranking/score is given at the end of the chapter. 

 
 

Activity VIII – Team Building 

For this activity, you have to work on the following problem: 
 
How can the problem of waste generation be solved? This could include e-waste, plastic waste, 
greenery/kitchen waste, hazardous waste etc. 
 
Get into groups of 7. 
Take a piece of paper. 
Any one member has to start with writing an idea to solve the problem on the paper. 
Then, pass the paper to the next person in the group. 
The next person has to build on the idea written by the first person and then pass it to the third person. 
The third person will then build on the idea written by the second person and so on. 
This will continue once all people in the group have built on the idea of the previous person. 
The final idea will then be discussed and refined by the group and shared with the class. 
 

Activity IX - Adaptability 
 
In this activity, we will make a story using other classmates’ inputs. To do this, please follow the steps 
given below: 
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Get in groups of 10. 
Any one person in the group has to start a story from “Once upon a time…..” and stop after speaking 
for around 1 minute. 
As the first person stops, the second person has to continue the story started by the first person. 
Similarly, after the second person speaks for 1 minute, the third person has to continue the story from 
where the second person stopped and so on. 
This goes on until the story is completed by the tenth person. 
 
After doing this exercise, reflect on the following questions: 
 
Did you find challenging to adapt to someone else’s story? Why? 
What did you learn about yourself from this exercise? 
One a scale of 1 to 10, how would you rate your skill of adaptability? 
 
 
 

 
Activity X – Problem Solving 

 
Read the statements below about different startups of India and how they define themselves. Based 
on that, and your own research, enlist the problems that these startups are trying to solve: 
 
1. Interview Bit is an interview preparation platform, especially designed for software engineers. It 
provides support to job candidates via a range of practice questions and on-demand mentors. 
 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
2. Cure.Fit is a startup in the fitness and healthcare industry. It has a chain of fitness centres which 
offer different types of fitness activities and classes everyday. It also has an part of called Eat.fit, where 
a customer can order healthy meals everyday.  
 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
3. 1mg is India’s leading consumer health platform by offering an online pharmacy network and 
generic medicine engine. It aspires to be the trusted health partner for all Indians and its mission is to 
make healthcare accessible, understandable and affordable for all Indians. Users can find information 
about medicines based on ailments, class, companies, and brands, and buy them.  
 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
4. EduKart is an online marketplace for education that aims to democratize education and bring more 
flexibility into the system. It offers both short certification courses and degree programmes for which 
it has partnered with renowned institutions. 
 

https://www.linkedin.com/company/curefit/?originalSubdomain=in
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___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
5. Recyclebank is encouraging people to recycle household waste by using gamification. The methods 
around gamification include rewards in the form of discount coupons on daily goods and services, 
points for making progress and a competitive element to encourage people to recycle household 
waste. Currently, Recyclebank has improved the process of recycling in more than three hundred 
communities and has more than four million members. 
 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
 

Activity XI – Problem Solving 
 
Read any daily newspaper of the last three days and make a list of problems that you think can be 
solved by starting a business or through an entrepreneurial project. Which problems did you come up 
with? 
 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
 

Activity XII - Creativity 

Scamper is a technique that guides you to think creatively about any existing product or service. It was 
created by Bob Eberle, an author of books about creativity for children. Scamper is a set of seven 
thinking techniques mean to assist those who utilize them in discovering atypical solutions to 
problems. SCAMPER is an acronym, with each letter representing a different technique that can used 
to trigger creative ideas: 

Substitute: Take one thing or part away and add something else. 
 
Combine: Put one or two things together to create something completely new. 
 
Adapt: Change something so that it can be used in a specific situation. 
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Modify/Minify/Magnify: Change size, shape or colour or any specific trait and reimagine it. 
 
Purpose/Put to Other Use: Use it in a way that it wasn’t meant to be used. Change the purpose it is 
used for. 
 
Eliminate: Remove any unnecessary element that might create an issue or a problem. 
 
Reverse/Rearrange: Change the direction or orientation. Look at it differently. May be move it upside 
down or use it backwards. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Use S.C.A.M.P.E.R. to build a better school desk/table or chair. Feel free to draw or write your ideas! 
 
1. What will you substitute? Can you change any parts? Can you change its shape, color or thickness? 
 
 
 
 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
2. What will you combine? Can you combine any materials, parts or ideas? 
 
 
 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 

Example:   
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___________________________________________________________________ 
 
3. What will you adapt? What else is like this? What other ideas does it suggest? Can you 
incorporate something? 
 
 
 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
4. Will you modify, minimize or maximize? Can you make something higher, bigger or stronger? Can 
you simplify something or make it smaller? 
 
 
 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
5. What else could I use it for? Can it be used in an unconventional way? 
 
 
 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
6. What will you eliminate? Can you think of something unnecessary that can be removed or 
omitted? 
 
 
 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
7. Will you reverse or rearrange any parts? What if you moved or turned it upside down? Can you 
imagine another layout or sequence? Can you interchange components or patterns? 
 
 
 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
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Activity XIII - Creativity 
 
Think of 10 unconventional uses of the following objects…. 
 
1. Paper Clip 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
2. Tennis Ball 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
3. Clothes Hanger 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
4. Feather 
__________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
5. Water bottle 
___________________________________________________________________ 
___________________________________________________________________ 
___________________________________________________________________ 
 
 

 

 

 

 

 

 

 

 

 

 

 

A 1 

Skill- Based Activities 

•  Research and administer a self- rating questionnaire and score responses on 
entrepreneurial competencies. 

• Collect a small story/ anecdote of prominent successful entrepreneurs. 

• Identify entrepreneurial competencies reflected in each story and connect it to the definition of 
entrepreneurial competencies. 

• Prepare a competency profile of yourself. 

• Participate in games and exercises on changing entrepreneurial behavior and development of 
competencies for enhancing self- confidence, problem solving, goal setting, information 
seeking, team building and creativity 
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Answer Key for Activity VII 

Item  
Actual Score |   (Individual                  
                              score) 

Actual Score      |    (group 
score) 

Box of matches         15          |             15              |  

Food concentrate          4           |            4                | 
Nylon rope, 50 feet          7           |          7                | 

Parachute silk          8           |          8                | 

Portable heater          5           |          5                | 

Two 0.45 caliber pistols         11          |          11               |  
Dehydrated pet milk, One 
case 

        12          |         12               | 

Two 100-Pound oxygen 
tanks 

         1           |          1                | 

Star Map-Moon 
Constellations 

         3           |          3                | 

Life raft          6           |          6                | 

Magnetic compass         14          |         14               | 

5 gallons of water          2           |          2                | 

Signal flares          13         |          13              | 
First-aid kits, injection 
needles 

         9           |           9                |  

Solar powered FM 
transmitter 

         10         |          10              | 
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To achieve the aim of more sustainable economy and society, the concept of Green Jobs came into 

existence. As discussed previously, the main objective of a sustainable society is 

judiciously using the natural resources for the present and future generation. 

In 2008 the United Nations Environment Programme (UNEP), the International 

Labour Organization (ILO), the International Trade Union Confederation (ITUC), and 

the International Employers Organization (IEO) jointly launched the Green Jobs 

Initiative. The purpose is to bring a just transition to a green economy by providing 

space for workers, employers, and governments to negotiate on policy effective in 

providing equitable opportunity to green jobs. 

Green Jobs: Towards Decent Work in a Sustainable, Low-Carbon 

World is the first comprehensive report on the emergence of a “green 

economy” and its impact on the world of work in the 21st Century. 

The report defines “green jobs” as work in agriculture, industry, 

services and administration that contributes to preserving or 

restoring the quality of the environment. Green jobs reduce the environmental impact of enterprises 

and economic sectors, ultimately to levels that are sustainable. 

Green jobs are found in many sectors of the economy from 

energy supply to recycling and from agriculture and construction 

to transportation. They help to cut the consumption of energy, 

raw materials and water through high-efficiency strategies, to 

de-carbonize the economy and reduce greenhouse-gas 

emissions, to minimize or avoid altogether all forms of waste and 

pollution, to protect and restore ecosystems and biodiversity. 

Green jobs play a crucial role in reducing the environmental 

footprint of economic activity. This reduction is gradual and the 

different jobs contribute to different degrees. Workers 

manufacturing fuel-efficient or hybrid cars, for example, 

contribute less to reducing emissions from transport than those 

working in public transport systems. Moreover, what is 

considered fuel-efficient today will no longer qualify in ten 

years’ time. The notion of a green job is thus not absolute, but 

there are ‘shades’ of green and the notion will evolve over time. 

            Class XII                        Green Skills 

1. Introduction 
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Until now, there has been much anecdotal evidence indicating that the pattern of employment is 

indeed changing—and that new jobs are beginning to emerge in favour of greener, cleaner and more 

sustainable occupations. 

 

 

Green innovation helps businesses stay at the cutting edge, retaining existing jobs and creating new 

ones. 

Modern economies mobilize enormous quantities of fuels, metals, minerals, lumber, and agricultural 

raw materials. Although some changes have been made in past decades to reduce the world 

economy’s environmental impact, these gains are insufficient and may simply be overwhelmed by 

continued economic growth. In view of the gathering environmental crisis, and especially the spectre 

of climate change, there is an urgent need to make economies far more sustainable and thus to re-

examine the prevailing production and consumption model. Concepts such as dematerialization, 

remanufacturing, “zero waste” closed-loop systems, durability, and replacing product purchases with 

efficient services (such as “performance contracting”) have been discussed for some time and tested 

in some instances, but by and large have yet to be translated into reality. Economic systems that are 

able to churn out huge volumes of products but require less and less labour to do so pose the dual 

challenge of environmental impact and unemployment. In the future, not only do jobs need to be 

greener, their very essence may need to be redefined. 

 

 

 

 

 

  

 

 

 

              2. What are the Key Drivers of Green Employment? 

A 1 

Hold a group discussion on possible ways to promote Sustainable Development. Do not forget to highlight 

the role of changing careers in propelling the idea of Sustainability. 
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3.1 Urban Growers: They manage terrace 

top gardens to grow fruits and vegetables in 

urban cities. They use environment friendly 

ways to grow fruits and vegetables. Today 

there is a shift in the demand of consumers. 

The rising instances of food adulteration 

and use of pesticides in the fruits and 

vegetables had paved a way for need of 

Organic food. Many people have their own 

organic gardens on roof tops to grow seasonal vegetables and fruits, while many do it as a hobby 

and love for gardening, there are many who do it for living. 

3.2 Clean Car Engineers: Recent initiations by Government on restricting the vehicular 

movement around Diwali time through ‘Odd-Even’ Scheme says a lot about the need of Clean 

Car Engineers. These people explore ways and means in which the cars don’t emit poisonous 

gases and keep the air clean to breathe. The Clean Car Engineers job is to design future 

transport that will be sustainable. This would not only mean to help keep air clean but also 

how to keep natural resources available for future generation without compromising the 

quality – as in average, engine life, durability etc. 

3.3 Biofuel Jobs: Biofuel is the non-conventional fuel that is sought for to run vehicles etc. 

without creating pollution. Since petrol and diesel create lot of pollution, there is a need to 

have clean fuel. It is felt that fuel from bio mass or natural matter can help resolve this 

problem. 

3.4 Building Roads with Plastic wastes: Engineers have found ways and means to solve two 

problems at one go. The waste plastic generated in tons over the globe can be utilized to make 

roads. This will not only provide better roads for vehicles to move but also solves the problem of 

waste generation. 

3.5 Solar Cell Technician: Use of solar energy is in high demand these days. This calls for the 

services and knowledge of Solar Cell Technicians. Using the right substance in the panels that 

is durable and affordable is a challenge. These 

people test the same on different substances for 

better results. 

3.6 Solar Panel Engineers & Installer: Solar 

Power Plant engineers and installers play very 

important role in successfully designing and 

installing solar plates to produce electricity. 

 

              3. Green Jobs 
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3.7 Wind Energy Workers: After the solar energy, wind energy is also sought for to produce 

electricity. Hence, the wind energy workers would be needed to lay down the plan for same. 

3.8 Wave Energy Producers: Another way to generate electricity without exhausting resources 

could be using the energy of waves from oceans. Since, 70% of our planet consists of water 

bodies, this could be useful in creating sustainable society. 

3.9 Water Quality Technicians: Water Pollution is in 

its alarming state. This has given rise to the need of 

Water Quality Technicians to help monitor the 

water quality and treat it. 

3.10 Rain Water Harvesting Engineers: With 

the rising problem of scarcity of water, need to 

build Rain Water pits are on demand. These are 

specialised to lay the plan and construct rain water 

harvesting systems (RWHS) for collecting the rain 

water and reusing same in buildings. The RWHS 

may also be used to replenish ground water level. 

3.11 Waste Water Treatment Workers: People involved in planning and constructing a 

system in green building to retreat the waste water from the same building and reutilizing it 

for secondary purposes. 

3.12 Recyclers: Waste generation across the globe has given rise to need of segregating 

waste. The recycler’s job is to segregate and collect the recyclable products. These days many 

recyclers are upcycling the waste products. Over time, the need of recyclers is going to 

increase. 

3.13 E-Waste Recyclers: With advancing technology, 

organisations and industries across the globe are facing the 

threat to dispose the e-waste generated by them. Many 

organisations have now started contacting special recyclers 

who collect all the electronic waste and recycle it. It is 

expected that in coming years, we will need more e-waste 

recyclers. 

3.14 Sewage Treatment Plants: The process 

to treat the waste in its impure form at a sewage 

treatment plant involves human engineering. 

People involved in the process will also have Green 

collar jobs. 
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3.15 Eco-Tourism: Eco-Tourism is 

relatively new area focussing on socially 

responsible travel, personal growth and 

environmental sustainability. This includes 

visiting fragile, pristine and undisturbed 

areas of nature. 

3.16 Green Builders: Green Builders 

ensure that environment friendly things are 

used to build houses and buildings. 

3.17 Green Design Professionals: The Green design professionals work in collaboration 

with Green Builders. They lay the idea of how the building will look like after its completion. 

The green design professionals also provide artistic beauty to buildings to make them look 

innovative and interesting. 

3.18 Energy Auditors: Energy Auditors inspect 

the buildings and measure heat, cooling, electrical 

and gas usage and find energy leakages in a 

structure. 

3.19 Energy Consultants: They help 

organisations 

analyse their energy consumptions with aim to 

reduce the same. 

3.20 Environmental Engineers: Environmental 

engineers provide solutions to environmental 

problems by using engineering, biology and 

chemistry. Providing solution to improve the quality 

of soil for better productivity, devising strategies to 

generate public electricity using renewable 

resources like solar street lights etc. is a part of 

environmental engineering. 

3.21 Natural Scientists: As we take step towards using sustainable means to create a 

sustainable society, it is very important to record and analyse the impact of our steps on 

environment. Natural Scientists help in achieving this aim. 

3.22 Working with a Non- Governmental Organisation (NGO): Working with an NGO 

for the cause of Environment provides opportunity to closely work for creating a sustainable 

and better society. 

3.23 Environmental Education Teacher: A teacher who takes up the role of sensitising 

young minds and creates acceptance amongst them to contribute in protecting environment. 

3.24  
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i. In toxin free homes: Collins English Dictionary defines Toxin as “any poisonous 

substance produced by bacteria, animals, or plants.” 

Do you think there are toxins in our environment? What is your view of toxins in our homes? 

Well, yes, there are toxins present in our environment and environment includes our homes 

also. Hence, the role of green jobs in our homes is to make it toxin free so that we have a 

healthy life. 

Toxins may be present in our homes in many ways such as – refrigerators releasing CFCs, 

cleaning and washing products, cosmetics, upholstery fabrics, rugs, mattresses, paint used on 

the wall, chemicals used to polish the floors, fragrances, some kind of clothes that uses 

chemicals, use of RO and Microwaves in our kitchens etc.   So, in order to ensure that our 

              4. Role of Green Jobs 

 

Choose any 4-5 Green Careers and prepare a brochure elaborating all the aspects like Educational 

Qualifications, Skills, Universities and colleges where these courses are available etc. 
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homes are safe from toxins and healthy places to breathe people with green collar jobs help 

us maintain a healthy environment. 

ii. In improving energy and raw material use: The exhaustive list of Green jobs mentioned above 

elaborately describes their role in 

improving the quality of energy. The 

energy produced through hydro-electric 

power plants, thermal power plants, 

nuclear power plants has grave 

consequences on the environment. Using 

alternate source of energy to produce 

electricity will not only minimize the 

exploitation of resources but will help the 

economy to flourish. 

iii. Limiting greenhouse gas emission: The alternates that the green jobs provide for sustainable 

development definitely help curb the emission of greenhouse gases. With the promotion of 

use of renewable sources in our homes and daily life, green jobs promise to limit the emission 

of harmful gases. 

iv. Minimizing waste and pollution: This problem has come a long way and the probable solution 

to this has been provided in 4Rs and 1U of sustainable development – REFUSE, REDUCE, 

REUSE, RECYCLE & UPCYCLE. Following these has definitely helped minimize the waste and 

pollution. But, the recyclers job at its best is trying to put a full stop to this problem. The 

concept of upcycling and the avenues it has created for a green market are luring and helps 

resolve this problem to a great extent. 

v. Protecting and restoring ecosystems: Various NGOs across the globe are working day and 

night to protect the wildlife, forests, endangered species etc. With their efforts we have been 

able to protect and restore the degrading eco system that would otherwise have collapsed 

much earlier. Their consciousness has certainly helped create awareness and sensitize masses 

to join hands together to have a sustainable ecosystem. 

 

vi. Promote adaptation to the effects of climate change: Natural Scientist at every point in time 

keeps us aware about the changes happening in our environment. It is because of them that 

we are able to prepare ourselves for the worst of the environmental changes and take 

measures to curb our ways to undo climate changes. 
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In groups, prepare a power point presentation elaborating and discussing the role of green jobs in our 

daily life. Remember to incorporate how Sustainable Development will be impacted in their absence. 

 

Sources 

https://en.wikipedia.org/wiki/Green_job#UNEP_Green_Jobs_Initiative 

https://www.ilo.org/wcmsp5/groups/public/---dgreports/---dcomm/documents/publication/wcms_098504.pdf  

https://www.ilo.org/wcmsp5/groups/public/@ed_emp/@emp_ent/documents/publication/wcms_158733.pdf 
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